B “Nigeriagric”

Agriculture &

Rural Development
Programs in Nigeria
“Nigeriagric”

Database User Guide

As part of its membership in the donor thematic
group on agriculture and rural development, CIDA
was requested to prepare on behalf of all donors
a user-friendly database containing an inventory
of the totality of donor-sponsored programming
in Nigeria, disaggregated by selected variables,
e.g., state, type of program, LGA. The completed
database forms part of a communications package
by development assistance agencies on the scope,
reach, volume, location and type of their respective
agriculture programming.

The database is a complete inventory of existing
and planned agriculture-related initiatives of
bilateral, multi-lateral and UN-affiliated
organizations in Nigeria from 2000 to 2010.
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GETTING STARTED

The Nigeriagric database v1.3is a "runtime" application; you do not need
additional software in order to use it.

MINIMUM SYSTEM REQUIREMENTS
To install and use the database, you need the following minimum system
configuration:

Pentium Il (Windows) or G3 (Mac OS) processor or faster computer with at
least 128 MB RAM (Mac OS) or 32 MB RAM (Windows g5, Windows g8,
Windows NT 3.51 or later, Windows Me, 2000 or XP) with at least 20 MB of
disk space available. Monitor with 8oox600 resolution (1024x768 or higher
strongly recommended).

Installing the Database

You'll need at least 20 megabytes of free space on your hard drive before you
can install the database.

Insert the Nigeriagric database CD in your CD-ROM drive, the CD will start
automatically and a Setup wizard will prompt you through the installation
process.

Installing Fonts

For the Nigeriagric database to display and print correctly, you should have
Arial, and Verdana fonts installed on your system. These fonts are included on
the CD-ROM in a folder titled “Fonts” To install new fonts to your computer

Click Start, point to Settings, click Control Panel, and then double-click Fonts.
If you don't see the item you want, click view all Control Panel options, and
then double-click the item.

On the File menuy, click Install New Font.

Locate the drive that contains the Nigeriagric database CD-ROM, and then
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open the folder titled ‘Fonts”.
Click the font you want to add.

Note: to select more than one font to add, press and hold down the ctrl key,
and then click each of the fonts you want.

Documentation

In the Nigeriagric database CD-ROM you will find a folder named,
“Documentation” This folder contains a user guide (this document) in PDF
format. You will need to install, or have Acrobat Reader on your computer in
order to access PDF documents. The electronic version of this document is
accessible by choosing “help” from the “Help” menu item.

Note: Adobe Acrobat is also required in order to view Donor Literature

Installing Acrobat Reader

A copy of Adobe Acrobat Reader is included in the “Extras folder” To install,
double-click the icon and follow the on-screen prompts

STARTING THE DATABASE
After installing the database, an icon will be placed on your desktop, double-
click the icon to start the application.

ENTER YOUR PASSWORD

Next, you will be prompted to enter the password assigned to you. If no
password has been assigned to you, your initial password to access the
database is "user".

CHANGING YOUR PASSWORD

You can change your initial password at anytime. To change your password
Choose FILE menu > Change Password.

In the Change Password dialog box, type the current password in the Old
password text box.
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Type the new password for New password, and again for Confirm new
password.
Click OK.

Change Password

Ilse these fields ko change the password For wour account. Please enter your old
passwiord ance and your new password bwice,

Account Mame: Adrnin

Old Password: ! |

Mew Passwaord: |

Confirm Mew Passward: I

Ik I Cancel

=

The Change Password Dialog box
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NAVIGATING THE DATABASE

THE DATABASE MAIN MENU

The database always opens with the main menu. You can access all the menu
commands and commonly used features from the main menu. While
navigating the database, you may return to the main menu at anytime by
choosing the “Main menu” command found under the “"Data” menu item.

NP TN (Nigeria ® ?
A ultlire ‘Rural Devel

griculttire Rural Development
Programs

DONORS PARTNERS PROGRAMS
Illtl'O(lll(‘ﬁOll DISPLAY PROGRAMS BY ZONE
Az part of its membership in the ]

donor themnatic group on agriculture
and mral development, CIDA was
requested to prepare on behalf of all DISPLAY PROGRAMS BY STATE
donors a user-friendly databasze
containing an inventary of the totality [2]

of donor-sponsored programming in

Nigeria, disaggregated by selected

warahles, &g, state, type of ADMINISTRATIVE DIVISIONS
program, LGA >

Migeria is divided into
6 geopaolitical zones,
36 states,
774 Local Government Areas (LGA)
and 9,955 wards

The Database Main menu
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All commands needed to use the Nigeriagric database are available from the
main menu.

Purpose codes: sector classification (OECD)

Is a system of classification by sector of destination developed and used by
the Organization for Economic Cooperation and Development (OECD) The
sector classification system refers to the specific areas of a recipient’s
economic or social structure a transfer is intended to foster, and not the type
of goods or services provided by the donor. Sector specific education or
research activities (e.g. agricultural education) or construction of
infrastructure (e.qg. agricultural storage) are to be reported under the sector to
which they are directed, not under education, construction, etc.

Printing Purpose Codes

You can print a single code, or a set of codes grouped by top-level DAC 5
heading. Click on the print button from the Purpose Codes main screen to
display the Print Codes dialog box, which provides the option to print a single
code or group of codes. If you choose the “Print group” option, another dialog
box is displayed from which you can then select the group of codes to print.
Note: You can only select one group at a time.

Audio Icon

Clicking the audio icon on the main menu brings up a screen that displays the
words to the National anthem and another audio icon that plays the music to
the national anthem when clicked

)

The audio icon will play music to the Nigerian National Anthem

Viewing Programs by Location

You can view programs in the database by state or geo-political zone by
selecting the name of the state or zone from the drop-down menu and
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clicking the button next to your selection.

DISPLAY PROGRAMS BY ZONE

Morth Central hd BR

DISPLAY PROGRAMS BY STATE

Benue || >

Use these drop-down menus to view programs in a particular state or geo-political zone

THE MENU BAR
The menu bar has four menu options, File, Data, Resources and Help.

The File Menu

Close (Ctrl+W)

This command will close the database files, but leave the Application running.
Always quit the application before turning off your computer to prevent damage to
the database files.

Print Setup

Use this feature to select a default printer, and change paper size and orientation.
Important: Printer and print setup options depend on the printer and system
software you're using. Refer to your printer and system documentation for more
information.

Print
The Print command opens the Print dialog box, which allows you to choose an
option before printing.
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To print Choose
All records in the found set Records being browsed
Only the record currently selected in Current record

Browse mode
A blank record using the current layout Blank record, showing fields, then
(use this option to print a blank "form") choose a formatting option

A list of all the fields defined for the file, | Field definitions

including formulas and entry options
A list of all script steps for one script or all | Script definition for, then choose a
scripts in the file specific script or all scripts

Select the print range, number of copies and other printing settings, and then
click OK.

Other print options depend on the printer and system software you're using.
Refer to your printer and system documentation.

Import Records

You can import data into the database from other applications. The records
you import become “the found set”. When you import, you can add new
records, replace or update existing data.

If you're replacing or updating data; first make a backup copy of the database;
replacing and updating will overwrite data and is irreversible.

In Browse mode, choose File menu> Import Records.

In the Open File dialog box, for Files of type (Windows) or Show (Mac OS.),
choose afile type to narrow the choices, or choose All Files to see all the files
in the current folder that you can import.

Select the name of the file to import, and then click Open.

If you're importing a Microsoft Excel file that contains more than one
worksheet or includes a named range, you see the Specify Excel Data dialog
box. Select the worksheet or named range that you want to import and click

10
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OK.

If you're importing a Microsoft Excel file, you see the First Row Option dialog
box. Choose whether the first row of data in the worksheet or named range is
field names or data.

In the Import Field Mapping dialog box, you can perform either of the
following actions at any time before you click Import:

* To view the data in the file you're importing from, click the Scan Data arrows
to see the data in each record.

e To create, change, or delete a field in the database, click Define Fields. In the
Define Fields dialog box, make your changes then click "Done”

In the Import Field Mapping dialog box, choose the type of import you want to
perform.

Choose To

Add new records Add new records to the end of the database

Replace datain current | Replace data in the database with data from the

found set source file, in order, starting with the first record in
each file
Update matching Update data in the found set with data in matching

records in current found | records in the file you are importing from
set

Add remaining records | Add records from the found set of the source file
that do not have matching records in the database

8. In the Import Fields Mapping dialog box, line up each field in the “Target
Fields” with the data or fields you want to import from (Source Fields).
Data on the left that is not aligned with a field on the right will not
import. If a field name on the right is dimmed, it's a calculation,
summary, or global field that can't accept imported data.

11
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Import Field Mapping @
Source: | agencies ﬂ Target: donaorsl
Source Fields | | Target Fields |4_\
Agency = # Agency —
Program = % Program
Qlwerview = # gowerview
SectorClassification = # SectorClassification
FundingSource =# # FundingSource
TimeFrame =¢ # TimeFrame
Locakions =# # Locations
ImplementingPartners = # ImplementingPartners
Chjectives =¢ # Objeckives
Fallahoratinatnencies = & Callaharabinabosncies bt

= | Field Mames EEEN T matching names

Impark Ackion Field Mapping

f* add new records = Import this Field

" |Updake existing recards in Found set — Dl it e e

(™ IUpdate matching records in Found set 8  Target cannot receive data
- Define Database. .. |
w

Impart | Cancel |

The Import Fields Mapping Dialog box

Export Records

This option allows you to export data to another program

In the dialog box that appears, type a name and select a location for the file.
Important: If another file with the same name already exists in the same
location, this new file replaces the existing file.

Choose a file type from the Save as type list

Use a file format supported by the application in which you plan to use the
exported data. (If you plan to export to Excel or Word, use the Tab-separated
Text Files (*.tab), or the Comma-separated Text Files (*.csv) formats)

12
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In the Specify Field Order for Export dialog box, indicate the fields that
contain the data you want to export from the selection on the left, and click
the "Move" button

When you are done, click the "Export" button.

Specify Field Order, for, Export @

Select and move the fields to be exported, IF wou want bo group data, choose the "aroup by Figlds
before moving the ather Fields,

Group by

Abia r [lagency
Abuja =
Adamawa
ADE
Agency
Akwwa Tham Field export order
Anarmbra
Bauchi
Bavelsa
Benue Movve Al
Eorno
CIDA Clear all
Collabaratingfaencies

Comments

Conskank

Count W

¥ fAgency

4l

Options
Qukput file character set; | Wwindowes [AM S]] ﬂ

| Apply currenk layout's data Formatting ko exported data Export | Cancel

The Specify Field Order for Export Dialog box

Recover

Use the Recover command to recover a damaged database file. The
application will attempt to repair and salvage as much of the information in a
damaged file as possible, and then creates a recovered file.

Note: Before you begin, be sure you have enough disk space for the recovered
file. If there isn't enough space, the recovered file won't be usable.

Exit

13
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Closes all open files and exits the application.

14
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The Data Menu

Main Menu

The main menu is displayed each time the database is launched. From the
main menu, you can access all the commands and features that make up the
database

Donors
This option features a submenu that provides access to the "Donors main
screen”, “show all” donors, Contacts List, add a “new"” donor, “delete” donor

record, and Implementing Partners associated with a particular donor.

III

Donors Main Screen

The Donors main screen displays all the information associated with a
particular donor. You can enter or modify donor information from the Donors
main screen only.

Show All
Choosing this option will display a list of all the donors in the database

Contacts List
This option displays a list of key contact person(s) for each donor in the

database

New
Choose this option to add a new donor to the database

Delete
Choose this option to permanently delete a donor’s record from the database

Implementing Partners
Choosing this option will display a list of Implementing Partners and programs

15
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associated with each donor. To view each donor and corresponding
Implementing Partners, use the navigational arrows at the top of the page

= L -2 s

Use these navigational arrows to move forward or backward one record at a time, or jump to
the first or last record

Programs
The Programs menu features a submenu that provides the option to display
all the programs in the database either by state, or geopolitical zones

ALL STATES (MAP)
Choosing this option displays a map of Nigeria with the six geopolitical
zones identified by different colors, states belonging to the same zone
have matching colors. The map also displays numbers representing
total program count for each state, clicking on a number will display a
list of the programs in that state.

ALL STATES
Choosing this option displays a list of programs in each of the 36 states
and FCT sorted in ascending order.

NORTH CENTRAL
Choosing this option displays a list of programs in the North Central
region states sorted in ascending order.

NORTH EAST
Choosing this option displays a list of programs in the North East region
states sorted in ascending order

NORTH WEST

Choosing this option displays a list of programs in the North West
region states sorted in ascending order.

16



DATABASE OF AGRICULTURE & RURAL DEVELOPMENT PROGRAMS IN NIGERIA

“NIGERIAGRIC”

SOUTH EAST
Choosing this option displays a list of programs in the South East region
states sorted in ascending order.

SOUTH WEST
Choosing this option displays a list of programs in the South West
region states sorted in ascending order.

SOUTH SOUTH
Choosing this option displays a list of programs in the South South
region states sorted in ascending order.

Find
Use this option to search the database for programs, implementing partners,
or donor agencies

The Resources Menu

The resources menu provides access to a number of useful articles, including
donor literature

Donor Literature
Donor literature features a collection of documents and reports generated by
donors in the course of implementation of their various programs

Administrative Divisions

Choosing this option brings up a list of all the states, and a map of the country
that highlights the currently selected state. Clicking on the name of any state
in the list will display its corresponding local governments. Clicking on the
navigational arrow at the top right corner of the screen will display a list of
programs in the currently selected state. Administrative divisions is also
accessible by clicking on the map of Nigeria appearing in the upper left corner
of every screen

17
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Environmental Reports on the States

Over a number of years, CDDI has been monitoring press reports in the major
newspapers of environmental problems in the 36 states. The Environmental
Reports on the states is based on analysis of media reports from 1999 to 2002.
The reports highlight major problems, as well as differences and similarities.

From the Environmental Reports screen, you can view the report for each
state by clicking on the name of the state. To print a report, click on the
“Print” button. Choosing the "Go to selected state” option takes you to a list
of donor sponsored activity in that state.

Vegetation and Land Use Analysis

Geomatics International (in collaboration with Geomatics Nigeria Ltd.)
conducted the World Bank funded project, "Assessment of Vegetation and
Land Use Changes in Nigeria between 1976/78 and 1993/95", during an 18
month time frame from 1994 to 1996 for Forestry Management, Evaluation
and Coordinating Unit (FORMECU), Nigeria.

The objective of the project was to develop current and reliable information
on vegetation change and degradation from 1976 to 1995. Work involved the
interpretation of land use and vegetation classes from a variety of satellite
data; creation of a GIS database; production of a variety of hard copy maps,
and conducting a change analysis to identify trends and the extent of
vegetation and land use change.

The findings from this exercise can be accessed by choosing the “vegetation
and land use analysis” command from the “Resources” menu

The Help Menu

From the Help menu, you can access the electronic version of this document
by choosing the “Help” command. For information on contacting the
developer, choose the "About” command.

18
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VIEWING DATA

The database provides two ways to view data, a "Form view", and a "Table
view". Form view displays a record at a time; while Table view enables you
view multiple records at once.

Form View

You can view and edit all the information associated with a particular donor in
Form view or "Donors main screen” only. Use the arrows located at the top
left corner of the screen to move forward or backward one record at a time, or
jump to the first or last record in the database.

= = < =3 b=

Use these navigational arrows to move forward or backward one record at a time, or jump to
the first or last record

Table View

If you were to choose “All States” from the “programs submenu” under the
“Data menu”, a list of all programs in all the states is displayed in “Table view".
In table view, multiple records are displayed on your screen at once.

19
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FINDING INFORMATION

You can have the database find a donor, implementing partner, or program,
etc, by choosing the “find” command from the "Data menu”. You can search
for a particular record or a group of records. To find records, you specify
search criteria e.g. Location, "Abuja”. A search examines all the records in the
database and returns the search results, (the "found set") the set of records
that matches the search criteria. The search results are displayed in Table
View. If a search returned only a record, it displays it in Form view. For
example, if you searched for "Abia" a list of all programs in Abia state (the
found set) is displayed in Table view. Clicking on the name of any Program in
the found set will take you to the Form view or "Donors Main screen" that
displays detailed information on that program.

FINDING A PROGRAM

To find a program or programs, choose the “Find” command from the “Data”
menu. You can find a program by Donor, Implementing Partner, Location, or
any other relevant search criteria. If only one program is found to match your
search criterig, it is displayed in the "Donors Main Screen” If more than one
program is found based on your search criteria, the “found set” is displayed in
table view, or no program was found, a list of all programs is displayed instead

REFINING A FIND REQUEST USING PURPOSE CODES

Purpose Codes is a system of classification by sector of destination developed
and used by the Organization for Economic Cooperation and Development
(OECD). In addition to classifying the various donor activities in the database,
the CRS codes can also be used as search criteria. For instance, a search for
donors using “capacity building” as search criteria might yield results not
relevant to the search; however, using CRS code “31110 - Agricultural policy
and administrative management” instead will limit the “found set” to a list of
only the Donors and programs that exactly match the criteria

20
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USING THE DATABASE

ENTERING DATA

You should only enter, or modify existing data in Form view or from the
"Donors Main screen". To modify existing data, click in the field or fields that
contain the data you wish to modify and simply type over it. To enter new
data, choose the "New"” command from the “"Donors” submenu and fill-in the
appropriate fields

An electronic data entry form in MS Word format for capturing donor activity
is included on the CD-ROM in the “Extras” folder. Donors should only use this
form to supply activity related information intended for inclusion in the
database.

21
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- Nigeria ® ?
Agricul- re Rural Development
Programs

FADAMA DEVELOPMENT PROJECT

Program
Fadarma Development Projed
Agency = Project Cost
African Development Bank (ADB) UA 22,000,000
Start Date End Date Time Frame
oct 12 2003 Dec 21, 2011 g years
Funding Source(s) == Sector Classification Locations
22,000,000 A0F 311 li ig'.g.fﬂ.o
31120 = Digawa
AGRICULTURE K atsina |
Objectives

Enhanced Agricultural productlon Productll.lltl,' and value T
addition for small holders and rural entrpreneurs in the |
Fadama areas in six states on a sustainable basis

Collaborating Agencies
B

EuENE(EY

3 S A N

Donors Main Screen

Entering and Updating Donor Information

To update information on an existing donor, first use the find command to
locate the donor. Once the database locates the donor, you should
automatically be taken to the "Donors Main Screen” If not, choose the
“Donors Main Screen” command from the "Donors submenu under the “"Data”
menu item, and use the navigational arrows to locate the donor. You should
now be able to view all the information associated with the particular donor.
Supply new information for this donor by typing over existing information.
Move through the data fields by clicking in the desired field, or using the tab
key on your keyboard.

22
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SORTING DATA

You can rearrange the order of (sort) the records in the database from Table
view only. You can sort in ascending or descending order simply by clicking on
the title of the column you wish to sort by. Clicking on a column heading once
will sort in ascending order (indicated by a small arrow next to the column
heading pointing UP); clicking twice will sort in descending order (indicated by
a small arrow pointing DOWN)

Sorting the Found Set

When a search returns multiple records, it displays them in table view. While
viewing a list of the found set, you can sort by either “agency” or “program”
by clicking on the appropriate column heading. Clicking once on a column
heading will sort alphabetically in Ascending order, clicking a column heading
twice will sort in descending order.

23
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o ﬁ.FRIC.RIN EH’LDPMENT BANK (ADB)
O AFRICAN DEYELOPMENT BANK (ADB)
) AFRICAN DEYELOPMENT BANK (ADB)
O AFRICAN DEYELOPMENT BANK (ADB)
) AFRICAN DEYELOPMENT BANK (ADB)
© AFRICAN DEYELOPMENT BANK (ADB)
) AFRICAN DEYELOPMENT BANK (ADB)
O CANADIAN INTERMATIONAL DEVELOPMENT AGENCY (CIDA)
) CANADIAN INTERNATIONAL DEYELOPMENT AGENCY {CIDA)

O CANADIAN INTERMATIONAL DEYELOPMENT AGENCY (CIDA)

“NIGERIAGRIC”

Nigeria Agriculture Rural Development

PROGRAM
izhange Forecast for Support to Forestry sector

Matural Resource Management Project

MERICA Rice Dissemination Project

Integrated Management of Invasive Aguatic Weeds in West Africa

Comrmmunity Based Agricultural and Rural Development Project

Fadara Developrent Project

Institutional Support To Agriculture and Rural Development

Promoting Sustainable Agriculture in Borno {(ProsaB)

Zanada-Migeria Environment Program (CHNEP)

Africa Stockpiles Programme ASP - Nigeria

A "Found Set” sorted in ascending order by "Agency”
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APPENDIX A - GLOSSARY

Word Meaning

Application Software that performs a specific task or function, such as word-processing,
creation of spreadsheets, generation of graphics, facilitating electronic mail, etc.

Ascending A sorting order that starts with the smallest (or oldest) value and ends with the

Sort largest (or most recent) value and proceeds in numerical order. For text, values are
arranged alphabetically (A-Z). Dates and times are sorted in chronological order.

Browsed Those records in the database that are currently visible.

Records

Browse Mode

In this mode, you can add, view, change, sort, omit (hide), and delete records.
Browse mode is where you'll do most of your work, like data entry

Current Field

The database field that is currently selected (by tabbing or clicking in the field).
Only the current field can be modified.

Current The record that is currently selected. Only the current record can be modified

Record

Database An organized collection of information, normally with one central topic.

Descending A sorting order that starts with the largest (or most recent) value and ends with

Sort the smallest (or oldest) value. An alphabetic sort in descending order begins with Z

Dimmed A menu command that cannot presently be selected—usually because it is

Command irrelevant to the current operation. Dimmed items are also referred to as “grayed
out” and can appear in dialog boxes as well as in menus.

Export To create a file in a program that can be read by another. To ensure compatibility
with the program that will receive the data, most programs that export data can
write it in a number of different file formats

Field Fields are the building blocks of which records are composed. Each database field
is meant to store one particular type of information, such as Date, or Amount etc.

File Any named collection of information that is stored on disk. Programs, documents,
and system software components are examples of files.

File Format A standard specification for the way data is stored on disk and interpreted.

Find A command for locating a record or group of records based on criteria you
establish

Found set The remaining visible (or browsed) records following a find procedure, such as a
find request.

Menu A list of choices presented by a program from which you can select an action.

Menus appear when you click menu titles in the menu bar
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Record The basic unit of every database. All databases are composed of records, each
storing information for a single entity, such as a person, catalog item, etc.

Search Information used as a reference in search or find operations

Criteria

Sort To rearrange database records in a different order than the one, which they were
originally entered.

Sort Order The order in which a field is sorted, e.g., ascending, descending.

APPENDIX B—LIST OF CRS PURPOSE CODES

DACs5 | CRS Clarifications / Additional notes on
CODE | CODE DESCRIPTION coverage
110 EDUCATION
Note: Sector specific education activities are to be included in the
respective sectors, either in a specific education code such as Agricultural
education or in a general code such as Communications
policy/administrative management.
The codes in this category are to be used
111 Education, level unspecified only when level of e.ducatior? is unspecified or
unknown (e.g. training of primary school
teachers should be coded under 11220).
Education sector policy, planning and
programmes; aid to education ministries,
Education policy and T’;\dn'.linis'tration a|.'1d ma.na.gement sys.tems;
11110 L . institution capacity building and advice;
administrative management
school management and governance;
curriculum and materials development;
unspecified education activities.
Educational buildings, equipment, materials;
11190 Education facilities and subsidiary services to education (boarding
training facilities, staff housing); language training;
colloquia, seminars, lectures, etc.
Teacher education (where the level of
11130 | Teacher training education is unspecified); in-service and pre-
service training; materials development.
Research and studies on education
11181 | Educational research effectiveness, relevance and quality;
systematic evaluation and monitoring.
112 Basic education
11220 | Primary education \ Formal and non-formal primary education
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DACs5 CRS Clarifications / Additional notes on
DESCRIPTION
CODE | CODE coverage
for children; all elementary and first cycle
systematic instruction; provision of learning
materials.
- . Formal and non-formal education for basic
Basic life skills for youthand | . .
11230 | o life skills for young people and adults (adults
education); literacy and numeracy training.
. . Formal and non-formal pre-school
11240 | Early childhood education . P
education.
113 Secondary education
: Second cycle systematic instruction at both
11320 | Secondary education oo .
junior and senior levels.
Elementary vocational training and
. - secondary level technical education; on-the
11330 | Vocational training . . . S .
job training; apprenticeships; including
informal vocational training.
114 Post-secondary education
Degree and diploma programmes at
11420 | Higher education universities, colleges and polytechnics;
scholarships.
11420 Advanced technical and Professional-level vocational training
43 managerial training programmes and in-service training.
120 HEALTH
121 Health, general
Health sector policy, planning and
. rogrammes; aid to health ministries, public
Health policy and prog >i 810 10 heatth MINISEries, publ
12110 . . health administration; institution capacity
administrative management - . .
building and advice; medical insurance
programmes; unspecified health activities.
. : . Medical education and training for tertiar
12181 | Medical education/training . g Y
level services.
. neral medical r rch ludin i
15182 | Medical research General medical research (excluding basic
health research).
Laboratories, specialised clinics and hospitals
(including equipment and supplies);
ambulances; dental services; mental health
12191 | Medical services care; medical rehabilitation; control of non-

infectious
diseases; drug and substance abuse control
[excluding narcotics traffic control (16361)].
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DACs5 CRS Clarifications / Additional notes on
CODE | CODE DESCRIPTION coverage
122 Basic health

Basic and primary health care programmes;
paramedical and nursing care programmes;
supply of drugs, medicines and vaccines
related to basic health care.

District-level hospitals, clinics and
dispensaries and related medical equipment;
excluding specialised hospitals and clinics
(22191).

Direct feeding programmes (maternal
feeding, breastfeeding and weaning foods,
child feeding, school feeding); determination
12240 | Basic nutrition of micro-nutrient deficiencies; provision of
vitamin A, iodine, iron etc.; monitoring of
nutritional status; nutrition and food hygiene
education; household food security.
Immunisation; prevention and control of
malaria, tuberculosis, diarrheal diseases,
vector-borne diseases (e.qg. river blindness
and guinea worm), etc.

Information, education and training of the
population for improving health knowledge
and practices; public health and awareness

12220 | Basic health care

12230 | Basic health infrastructure

12250 | Infectious disease control

12281 | Health education

campaigns.
19282 Health personnel Training of health staff for basic health care
development services.
130 POPULATION POLICIES/PROGRAMMES AND REPRODUCTIVE HEALTH
Population/development policies; census
. . work, vital registration; migration data;
Population policy and . . .
13010 demographic research/analysis; reproductive

administrative management . :
g health research; unspecified population

activities.

Promotion of reproductive health; prenatal
and postnatal care including delivery;
prevention and treatment of infertility;
prevention and management of
consequences of abortion; safe motherhood
activities.

Family planning services including
counselling; information, education and

13020 | Reproductive health care

13030 | Family planning
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DAC5
CODE

CRS
CODE

DESCRIPTION

Clarifications / Additional notes on
coverage

communication (IEC) activities; delivery of
contraceptives; capacity building and
training.

13040

STD control including
HIV/AIDS

All activities related to sexually transmitted
diseases and HIV/AIDS control e.g.
information, education and communication;
testing; prevention; treatment, care.

13081

Personnel development for
population and reproductive
health

Education and training of health staff for
population and reproductive health care
services.

140

WATER SUPPLY AND SANITATION

14010

Water resources policy and
administrative management

Water sector policy, planning and
programmes; water legislation and
management; institution capacity building
and advice; water supply assessments and
studies; groundwater, water quality and
watershed studies; hydrogeology; excluding
agricultural water resources (31140).

14015

Water resources protection

Inland surface waters (rivers, lakes, etc.);

conservation and rehabilitation of ground
water; prevention of water contamination
from agro-chemicals, industrial effluents.

14020

Water supply and sanitation -
large systems

Water desalination plants; intakes, storage,
treatment, pumping stations, conveyance
and distribution systems; sewerage;
domestic and industrial waste water
treatment plants.

14030

Water supply and sanitation -
small systems

Water supply and sanitation through low-
cost technologies such as handpumps, spring
catchment, gravity-fed systems, rain water
collection, storage tanks, small distribution
systems; latrines, small-bore sewers, on-site
disposal (septic tanks).

14040

River development

Integrated river basin projects; river flow
control; dams and reservoirs [excluding dams
primarily for irrigation (31140) and
hydropower (23065) and activities related to
river transport (21040)].

14050

Waste management/disposal

Municipal and industrial solid waste
management, including hazardous and toxic
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DACs5 CRS Clarifications / Additional notes on
CODE | CODE DESCRIPTION coverage

waste; collection, disposal and treatment;
landfill areas; composting and reuse.

Education and training in
water supply and sanitation
150 GOVERNMENT AND CIVIL SOCIETY

Macro-economic, fiscal and monetary policy
and planning; social planning; economic and
social analysis and forecasting; structural
Economic and development | reforms; development planning;
policy/planning organisational development; support to
ministries involved in aid co-ordination; other
ministries and government departments
when sector cannot be specified.
Strengthening financial and managerial
accountability; public expenditure
management; improving financial
management systems; tax assessment
procedures; budget drafting; field auditing;
measures against waste, fraud and
corruption.

Constitutional development, legal drafting;
institutional strengthening of legal and
judicial systems; legal training and
education; legal advice and services; crime
prevention.

Systems of government including
parliament, local government,
decentralisation; civil service and civil service
reform.

Community participation and development;
co-operatives; grassroots organisations;
15050 | Strengthening civil society development of other participatory planning
and decision making procedures and
institutions.

Participation in the post-conflict peace-
building phase of United Nations peace

Post conflict peace-building | operations (activities such as human rights
(UN) and elections monitoring, rehabilitation of
demobilised soldiers, rehabilitation of basic
national infrastructure, monitoring or

14081

15010

Public sector financial

15020
management

Legal and judicial

15030 development

15040 | Government administration

15061
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DACs5 CRS Clarifications / Additional notes on
CODE | CODE DESCRIPTION coverage

retraining of civil administrators and police
forces, training in customs and border
control procedures, advice or training in fiscal
or macroeconomic stabilisation policy,
repatriation and demobilisation of armed
factions, and disposal of their weapons;
support for landmine removal).

Electoral assistance and monitoring, voters’
15062 | Elections education [other than in connection with
peace building (15061)].

Monitoring of human rights performance;
support for national and regional human
15063 | Human rights rights bodies; protection of ethnic, religious
and cultural minorities [other than in
connection with peace building (15061)].
Integration of demobilised military personnel
into the economy; (micro)-disarmament;
15064 | Demobilisation conversion of production facilities from
military to civilian outputs [other than in
connection with peace building (15061)].
Uncensored flow of information on public
issues, including activities that increase the
15065 | Free flow of information professionalism, skills and integrity of the
print and broadcast media (e.g. training of
journalists).

Explosive mine removal for developmental

15066 | Land mine clearance purposes [other than in connection with
peace building (15061)].
160 OTHER SOCIAL INFRASTRUCT-URE AND SERVICES
161 Employment

Employment policy and planning; labour law;
labour unions; institution capacity building

Employment policy and and advice; support programmes for

16110 . . unemployed; employment creation and
administrative management | . .
income generation programmes;
occupational safety and health; combating
child labour.
162 Housing
16210 Housing policy and Housing sector policy, planning and

administrative management | programmes; excluding low-cost housing
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DACs5 CRS Clarifications / Additional notes on
CODE | CODE DESCRIPTION coverage
and slum clearance (16220).
16220 | Low-cost housing Including slum clearance.
163 Other social services
Social legislation and administration;
institution capacity building and advice;
social security and other social schemes;
. . special programmes for the elderly, orphans,
16310 | Socialf welfare services the disabled, street children; social
dimensions of structural adjustment;
unspecified social infrastructure and services,
including consumer protection.
General services by government (or
commissioned by government) e.g. police,
16320 | General government services | fire protection; cartography, meteorology,
legal metrology, aerial surveys and remote
sensing; including administrative buildings.
16330 | Settlement Land settlement/.compensation;
resettlement of displaced persons.
16340 | Reconstruction relief Multisectoral social.programmes after
emergency or conflict.
16350 | Culture and recreation Including libraries and museumes.
In-country and customs controls including
training of the police; educational
16361 | Narcotics control programmes and awareness campaigns to
restrict narcotics traffic and in-country
distribution.
16362 | Statistical capacity building Both in national stati.st?cal.offices and any
other government ministries.
16381 Res.earc.h/saentlflc When sector cannot be identified.
institutions
210 TRANSPORT AND STORAGE
Note: Manufacturing of transport equipment should be included under code
32172.
Transport sector policy, planning and
Transport policy and Programmes; aiq to trz.ans.port minist.ries;
21010 L . institution capacity building and advice;
administrative management . 7 .
unspecified transport; activities that combine
road, rail, water and/or air transport.
Road infrastructure, road vehicles; passenger
21020 | Road transport

road transport, motor passenger cars.
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DACs5 CRS Clarifications / Additional notes on
DESCRIPTION
CODE | CODE coverage
Rail infrastructure, rail equipment,
21030 | Rail transport locomotives, other rolling stock; including
light rail (tram) and underground systems.
Harbours and docks, harbour guidance
systems, ships and boats; river and other
21040 | Water transport >  SNIP !
inland water transport, inland barges and
vessels.
Airports, airport guidance systems,
21050 | Airtransport aeroplanes, aeroplane maintenance
equipment.
21061 | Storage Whether or not related to transportation.
Education and training in
21081
transport and storage
220 COMMUNICATIONS
Communications sector policy, planning and
I . rogrammes; institution capacity buildin
Communications policy and programmes; . pactty 9
22010 . . and advice; including postal services
administrative management e -
development; unspecified communications
activities.
_ Telephone networks, telecommunication
22020 | Telecommunications . .
satellites, earth stations.
. L . . Radio and TV links, equipment; newspapers;
22030 | Radio/television/print media - = €qUIP ! Papers;
printing and publishing.
230 ENERGY GENERATION AND SUPPLY
Note: Extraction of raw materials for power generation should be included
in the mining sector. Energy manufacturing should be included in the
industry sector.
Energy sector policy, planning and
. rogrammes; aid to energy ministries;
Energy policy and progran T <ray !
23010 e . institution capacity building and advice;
administrative management e LT .
unspecified energy activities including
energy conservation.
: Thermal power plants including when heat
Power generation/non- . .
23020 source cannot be determined; combined gas-
renewable sources
coal power plants.
Including policy, planning, development
23030 Power generation/renewable | programmes, surveys and incentives.

sources

Fuelwood/ charcoal production should be
included under forestry (31261).
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DACs5 CRS Clarifications / Additional notes on
CODE | CODE DESCRIPTION coverage
23040 Electrical transmission/ Distribution from power source to end user;
distribution transmission lines.
23050 | Gas distribution Delivery for use by ultimate consumer.
23061 | Oil-fired power plants Including diesel power plants.

23062 | Gas-fired power plants
23063 | Coal-fired power plants
23064 | Nuclear power plants Including nuclear safety.

23065 | Hydro-electric power plants | Including power-generating river barges.
23066 | Geothermal energy

Including photo-voltaic cells, solar thermal
applications and solar heating.

Wind energy for water lifting and electric
power generation.

Including ocean thermal energy conversion,
tidal and wave power.

Densification technologies and use of
biomass for direct power generation

23067 | Solar energy

23068 | Wind power

23069 | Ocean power

23070 | Biomass including biogas, gas obtained from sugar
cane and other plant residues, anaerobic
digesters.

23081 | Energy education/training Ap!alies to all energy sub-sectors; all levels of
training.

23082 | Energy research Including general inventories, surveys.

240 BANKING AND FINANCIAL SERVICES

Finance sector policy, planning and
programmes; institution capacity building
and advice; financial markets and systems.
24020 | Monetary institutions Central banks.

All formal sector financial intermediaries;

Financial policy and

24010 - .
% administrative management

Formal sector financial

24030 | . o insurance, leasing, venture capital, etc.
4939 | intermediaries f 9 prat,
(except when focused on only one sector).
D AOLO Informal/semi-formal Micro credit, savings and credit co-operatives
4949 | financial intermediaries etc.

Education/training in
24081 | banking and financial

services
250 BUSINESS AND OTHER SERVICES
Business support services Support to trade and business associations,
25010 o
and institutions chambers of commerce; legal and regulatory
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DAC5
CODE

CRS
CODE

DESCRIPTION

Clarifications / Additional notes on
coverage

reform aimed at improving business and
investment climate; private sector institution
capacity building and advice; trade
information; public-private sector
networking including trade fairs; e-
commerce. Where sector cannot be
specified: general support to private sector
enterprises (in particular, use code 32130 for
enterprises in the industrial sector).

25020

Privatisation

When sector cannot be specified. Including
general state enterprise restructuring or
demonopolisation programmes; planning,
programming, advice.

311

AGRICULTURE

31110

Agricultural policy and
administrative management

Agricultural sector policy, planning and
programmes; aid to agricultural ministries;
institution capacity building and advice;
unspecified agriculture.

31120

Agricultural development

Integrated projects; farm development.

31130

Agricultural land resources

Including soil degradation control; soil
improvement; drainage of water logged
areas; soil desalination; agricultural land
surveys; land reclamation; erosion control,
desertification control.

31140

Agricultural water resources

Irrigation, reservoirs, hydraulic structures,
ground water exploitation for agricultural
use.

31150

Agricultural inputs

Supply of seeds, fertilizers, agricultural
machinery/equipment.

31161

Food crop production

Including grains (wheat, rice, barley, maize,
rye, oats, millet, sorghum); horticulture;
vegetables; fruit and berries; other annual
crops.

31162

Industrial crops/export crops

Including sugar; coffee, cocoa, tea; oil seeds,
nuts, kernels; fibre crops; tobacco; rubber.

31163

Livestock

Animal husbandry; animal feed aid.

31164

Agrarian reform

Including agricultural sector adjustment.

31165

Agricultural alternative
development

Projects to reduce illicit drug cultivation
through other agricultural marketing and
production opportunities (see code 43050 for
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DACs5 CRS Clarifications / Additional notes on
CODE | CODE DESCRIPTION coverage
non-agricultural alternative development).
31181 Agricultural
education/training
31182 | Agricultural extension Non-formal training in agriculture.
Including plant breeding, physiology, genetic
31183 | Agricultural research resources, ecology, taxonomy, disease
control, agricultural bio-technology.
31184 | Livestock research Includ.ing anirr.w.\I health, 'breeding and
genetics, nutrition, physiology.
Marketing policies & organisation; storage
31191 | Agricultural services and transportation, creation of strategic
reserves.
Including integrated plant protection,
Plant and post-harvest biological plant protection acti\{ities, supply
31192 . and management of agrochemicals, supply
protection and pest control L . .
of pesticides, plant protection policy and
legislation.
Financial intermediaries for the agricultural
31193 | Agricultural financial services | sector including credit schemes; crop
insurance.
31194 | Agricultural co-operatives Including farmers’ organisations.
. : . Animal health and management, genetic
31195 | Livestock/veterinary services
resources, feed resources.
312 FORESTRY
Forestry sector policy, planning and
31210 Forestry policy and programmes; institution capacity building
administrative management | and advice; forest surveys; unspecified
forestry and agro-forestry activities.
Afforestation for industrial and rural
consumption; exploitation and utilisation;
31220 | Forestry development . P
erosion control, desertification control;
integrated forestry projects.
Forestry development whose primary
31261 | Fuelwood/charcoal purpose is production of fuelwood and
charcoal.
31281 | Forestry education/training
Including artificial regeneration, genetic
31282 | Forestry research improvement, production methods,

fertilizer, harvesting.
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DACs5 CRS Clarifications / Additional notes on
CODE | CODE DESCRIPTION coverage
31291 | Forestry services
313 FISHING
Fishing sector policy, planning and
programmes; institution capacity building
Fishing policy and and advice; ocean and coastal fishing; marine
31310 = . , .
administrative management | and freshwater fish surveys and prospecting;
fishing boats/equipment; unspecified fishing
activities.
Exploitation and utilisation of fisheries; fish
31320 | Fishery development stock protection; aquaculture; integrated
fishery projects.
31381 | Fishery education/training
. Pilot fish culture; marine/freshwater
31382 | Fishery research . .
biological research.
31391 | Fishery services Fishing harbours; fish markets; fishery
transport and cold storage.
321 INDUSTRY
Note: Only includes aid to production or manufacturing. Provision of
finished products should be included under relevant sector.
Industrial sector policy, planning and
Industrial policy and programmes; institution capacity building
32110 . . . e : L
administrative management | and advice; unspecified industrial activities;
manufacturing of goods not specified below.
32120 | Industrial development
Direct support to the development of small
and medium-sized enterprises in the
32130 | SME development industrial sector, includinpg accounting,
auditing and advisory services.
32140 Cottage industries and
handicraft
Staple food processing, dairy products,
slaughter houses and equipment, meat and
32161 | Agro-industries fish processing and preserving, oils/fats,
sugar refineries, beverages/tobacco, animal
feeds production.
32162 | Forestindustries Wood production, pulp/paper production.
32163 ;I'jgzltlii;:eesather and Including knitting factories.
32164 | Chemicals Industrial and non-industrial production
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DACs5 CRS Clarifications / Additional notes on
CODE | CODE DESCRIPTION coverage
facilities; includes pesticides production.
32165 | Fertilizer plants
32166 | Cement/lime/plaster
32167 | Energy manufacturing Inc.ludi.ng gas liquefaction; petroleum
refineries.
32168 | Pharmaceutical production Med'!c.al equipm.ent/suppllies'; drugs,
medicines, vaccines; hygienic products.
32169 | Basic metal industries Iron and steel, structural metal production.
32170 | Non-ferrous metal industries
. , Manufacturing of electrical and non-
32171 | Engineering : . . .
electrical machinery, engines/turbines.
Shipbuilding, fishing boats building; railroad
32172 Transport equipment equipment; motor vehicles and motor
industry passenger cars; aircraft; navigation/guidance
systems.
Technological research and Including industrial standards; .quality
32181 development management; metrology; testing;
accreditation; certification.
322 MINERAL RESOURCES AND MINING
Mineral and mining sector policy, planning
and programmes; mining legislation, mining
32210 Mineral/mining policy and cadastre, mineral resources inventory,
administrative management | information systems, institution capacity
building and advice; unspecified mineral
resources exploitation.
Geology, geophysics, geochemistry;
excluding hydrogeology (14010) and
32220 Mineral prospection and environmental geology (41010), mineral
exploration extraction and processing, infrastructure,
technology, economics, safety and
environment management.
32261 | Coal Including lignite and peat.
. Petroleum, natural gas, condensates, LPG,
32262 | Oiland gas LNG; including drilling and production.
32263 | Ferrous metals Iron and ferro-alloy metals.
32264 | Nonferrous metals Aluminium, copper, lead, nickel, tin, zinc.
32265 | Precious metals/materials Gold, silver, platinum, diamonds, gemstones.
32266 | Industrial minerals Baryte, limestone, feldspar, kaolin, sand,

gypsym, gravel, ornamental stones.

38




DATABASE OF AGRICULTURE & RURAL DEVELOPMENT PROGRAMS IN NIGERIA

“NIGERIAGRIC”

DACs5 CRS Clarifications / Additional notes on
CODE | CODE DESCRIPTION coverage
32267 | Fertilizer minerals Phosphates, potash.

Polymetallic nodules, phosphorites, marine

32268 | Offshore minerals .
placer deposits.

323 CONSTRUCTION

Construction sector policy and planning;
Construction policy and excluding construction activities within
administrative management | specific sectors (e.g., hospital or school
construction).
331 TRADE POLICY AND REGULATIONS
Trade policy and planning; support to
ministries and departments responsible for
trade policy; trade-related legislation and
regulatory reforms; analysis and
implementation of multilateral trade
Trade policy and agreements e.g. technical barriers to trade
administrative management | and sanitary and phytosanitary measures
(TBT/SPS); mainstreaming trade in national
development strategies (e.g. poverty
reduction strategy papers); wholesale/retail
trade; unspecified trade and trade promotion
activities.
Simplification and harmonisation of
international import and export procedures
(e.g. customs valuation, licensing
procedures, transport formalities, payments,
insurance); support to customs departments;
tariff reforms.
Support to regional trade arrangements (e.qg.
Regional trade agreements SADC, ASEAN, FTAA, ACP/EU); elaboration
33130 I, ) . .
(RTAS) of rules of origin and introduction of special
and differential treatment in RTAs.
Support aid recipients’ effective participation
in multilateral trade negotiations, including
training of negotiators, assessing impacts of
negotiations; accession to WTO and other
multilateral trade-related organisations.
Human resources development in trade not
33181 | Trade education/training included under any of the above codes.
Includes university programmes in trade.

32310

33110

33120 | Trade facilitation

Multilateral trade

33140 negotiations

332 TOURISM
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DACs5 CRS Clarifications / Additional notes on
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Tourism policy and
administrative management
400 MULTISECTOR/CROSS-CUTTING

Note: Sector specific environmental protection and gender equality/WID
activities should be included in the respective sectors, and the environment
and gender equality marker checked. Multi-sector/cross-cutting includes
only environment and WID activities not allocable by sector.

General environmental
protection

33210

410 Non-sector specific.

Environmental policy, laws, regulations and
economic instruments; administrational
institutions and practices; environmental and
land use planning and decision-making
procedures; seminars, meetings;
miscellaneous conservation and protection
measures not specified below.

Air pollution control, ozone layer
preservation; marine pollution control.
Including natural reserves and actions in the
surrounding areas; other measures to protect
endangered or vulnerable species and their
habitats (e.g. wetlands preservation).
Applies to unique cultural landscape;
including sites/objects of historical,
archeological, aesthetic, scientific or
educational value.

Floods from rivers or the sea; including sea
41050 | Flood prevention/control water intrusion control and sea level rise
related activities.

Environmental policy and

1010 ., .
4 administrative management

41020 | Biosphere protection

41030 | Bio-diversity

41040 | Site preservation

Environmental education/

41081 training

Including establishment of databases,
inventories/accounts of physical and natural
resources; environmental profiles and impact
studies if not sector specific.

420 Women in development Non-sector specific.

Including multisectoral WID projects and
programmes; promotion of and support to
WID groups and networks; conferences,
seminars, etc.

41082 | Environmental research

42010 | Women in development
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430 Other multi-sector

43010 | Multi-sector aid

Basic social services are defined to include
Multi-sector aid for basic basic education, basic health, basic nutrition,
social services population/reproductive health and water
supply and sanitation — small systems.
Integrated urban development projects;
local development and urban management;
urban infrastructure and services; municipal
finances; urban environmental
management; urban development and
planning; urban renewal and urban housing;
land information systems.

Integrated rural development projects; e.g.
regional development planning; promotion
of decentralised and multi-sectoral
competence for planning, co-ordination and
management; implementation of regional
development and measures (including
natural reserve management); land
management; land use planning; functional
integration of rural and urban areas;
geographical information systems.

Projects to reduce illicit drug cultivation
through, for example, non-agricultural

43020

Urban development and

43030 management

43040 | Rural development

Non-agricultural alternative

43050 development ?ncome opportunities, social and phys'ical
infrastructure (see code 31165 for agricultural
alternative development).

43081 Zﬂﬂz;iieocrf/?c;aining Including scholarships.

500 COMMODITY AID AND GENERAL PROGRAMME ASSISTANCE
Note: Sector specific programme assistance is to be included in the
respective sectors, using the structural adjustment flag if appropriate.
Structural Adjustment Includes structural adjustment programmes
510 Assistance with World either cofinanced with or undertaken in co-
Bank/IMF ordination with the World Bank and the IMF.
51010 | Structural adjustment When not allocable by sector.
520 Developmental food aid/Food security assistance
Food aid/Food security Supply of edible human food under national
52010 programmes or international programmes including
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transport costs; cash payments made for
food supplies; project food aid; food aid for
market sales; excluding emergency food aid.

530 Other general programme and commodity assistance
010 Balance-of-payments Including general programme assistance
>3 support (when not allocable by sector).
53020 | Budget support Including administrative budget support.
53030 Import support (capital Capital goods and services; lines of credit.
goods)
Import support Commodities, general goods and services, oil
53040 o .
(commodities) imports.
600 ACTION RELATING TO DEBT

Actions falling outside the code headings

60010 | Action relating to debt L2
9 below; training in debt management.

60020 | Debt forgiveness

Grants or credits to cover debt owed to
60030 | Relief of multilateral debt multilateral financial institutions; including
contributions to HIPC Trust Fund.

Rescheduling and

60040 refinancing

Allocation of debt claims to use for

60061 | Debt for developmentswap | development (e.g., debt for education, debt
for environment).

Where the debt swap benefits an external

60062 | Other debt swap agenti.e. is not specifically for development
purposes.
60063 | Debt buy-back Purchase. of debt for the purpose of
cancellation.
700 EMERGENCY ASSISTANCE
710 Emergency food aid

Food aid normally for general free
distribution or special supplementary feeding
programmes; short term relief to targeted
population groups affected by emergency
situations. Excludes food security assistance
programmes/food aid (52010).

720 Other emergency and distress relief

All emergency, distress relief and
humanitarian aid except food aid and aid to

71010 | Emergency food aid

72010 | Emergency/distress relief
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refugees; disaster preparedness.
Aid to refugees (in donor
72020
country)
72030 ?cl)cLlj:t)rir:;Jgees (in recipient Including internally displaced people.
910 ADMINISTRATIVE COSTS OF DONORS
91010 | Administrative costs
SUPPORT TO NON- Official funds to be paid over to national and
920 GOVERNMENTAL international private voluntary agencies for
ORGANISATIONS use at the latters’ discretion.
92010 | Support to national NGO's In the donor country.
92020 Support to international
NGO'’s
92030 Supplort tolocal and regional In the recipient country or region.
NGO'’s
998 UNALLOCATED/ UNSPECIFIED
Contributions to general development of the
99810 | Sectors not specified recipient should be included under
programme assistance (53010).
Spending in donor country for heightened
Promotion of development awareness/interest in development co-
99820 awareness operation (brochures, lectures, special
research projects, etc.).
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